Seradex OrderStream
Technical Release Notes
June 2013
AcctMaintenance.dll

6.4.57

06/28/2013

I1306037

The CRM's CustomerShipTo and CustomerBillTo will now be called from
Account Maintenance.

06/28/2013

I1305168

The Admin Tool's Transaction Override form will now set the correct max
character length of the 'New Transaction No.' field upon selection of the
'Transaction Type' combo and the 'Change No' option.

06/28/2013

I1305215

New validation has been added to ensure the selected commission group
cannot be deleted if it is associated to customers, prospects, commission
groups and sales transactions.

06/28/2013

I1306028

Updating a mastered item will no longer recopy the reorder level or quantity
from the product line item.
Config property excel filtered values that are setup using named ranges in
workbooks will now work correctly if the range does not start in the first
column.
The group line properties will now retain its grey background when the undo
button is clicked on the Configurator Setup.
Copying property values from one product line configuration to another when
the "Enable Property Selections Copying" is on will now allow the user to
copy query controlled property values as well.
The property value list loading process has been modified to be more
efficient by querying the database only once when loading the combo boxes
that share the same properties.

ActiveM20.dll

6.4.73

Commissions.dll

6.4.16

Config.dll

6.4.98

I1304204

I1306057
I1306034

I1305214

CreditNote.dll

6.4.61

06/28/2013

I1306010
I1305163

The reference field max length has been adjusted to 200 characters to
correspond with the max length allowed in the database.
Reporting options are now disabled while a report is being generated.

CRM.dll

6.4.69

06/28/2013

I1306037
I1208046
I1306031

The CRM's CustomerShipTo and CustomerBillTo will now be called from
Account Maintenance.
If there are unsaved changes in the CRM Activity form when the user closes
the form, they will be prompted if they would like to save their changes.
Searches launched from CRM will now be filtered property when an alternate
customer combo setup is selected in application preferences.
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6.4.69

06/28/2013

I1306081

The form has been changed to prompt the user if they wish to save any
changes prior to closing the form using the x button on top right corner of the
form. If the user clicks yes, the form will save the changes and then close the
form. If the user clicks no, the form will close without saving.

I1306092

The size of the Lot Number field in all appropriate tables has been increased
from 25 characters to 50 characters.
The Integrity Check 'Items with Multiple Operations within its Labour
Schedule that have ExcludeFromFiniteScheduling Unchecked' will now run
on Sql05 databases.
Add POInvoicingPaymentTypes and DepositInvoice Flag to Vendor Invoice

DataTransfer.mdb

6.4.133

06/28/2013

I1306049

I1210232
I1306071
I0905163
I1306083
I1306009
I1209113
I1306150
I1306048

I1306035

I1305225
I1305139

The PO Invoice No column has been removed from the vendor invoice
search.
Checks have been added to existing update records to ensure they are only
run once.
The Estimate data source will no longer prompt the 'CustTax' error message
when picking Estimate as the data source on the smart finder form.
The Mat Req Audit Trail report query has been modified to pull only POs that
are associated to Mat Req records.
The InvoiceTypeCode characters length from the InvoiceType table has been
adjusted from 3 characters to 50 characters.
An integrity check has been added to detect invalid Rack and Bin setup for
items.
Altered the Financials integrity check "Financials - Invalid GL Account Type
for AP Accrual Account" to also allow use of the Other Payable GL account
type
Altered Financials search Inventory GL Balance Audit will show current
balance for any GL account deemed to have inventory not just those flagged
as material GL accounts
All UpdateActiveM records which were modifying the Modules table have
been removed.
The character length allow for dbo.ModuleSetup.SetupQuery has been
adjusted from 8000 to Max.

DayEndProc.dll

6.4.97

06/28/2013

I1305242
I1305226
I1303272

I1306153

Alter day end for great Plains Econnect to prevent issues with two users
running an AR batch for the same invoices at the same time
Update BV 7 Posting so the Fiscal year and period is derived from the
document date as opposed to the date the user sets the batch date to.
For MYOB Link when a PO Invoice Detail Line has tax and the line needs to
be broken out in the batch due to variances etc then instead of showing the
total tax on the first line instead prorate it across all the lines as if each one
was a vendor invoice line
Altered MYOB Link to ensure item descriptions with line breaks do not cause
issues with the CSV file
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DC2001.dll

6.4.31

06/28/2013

I1302178
I1304195
I1303142

The DataCollection form will now allow the creation of secondary worker
record(s).
If the Start Datetime is greater than the Finish Datetime, the correct hours,
negative, will be calculated.
Data collection document lines can no longer be deleted by users who are
not authorized to delete data collection documents.

Estimating.dll

6.4.89

06/28/2013

I1305163

Reporting options are now disabled while a report is being generated.

I1306018

The Sales Order detail "Due Date" field for a make item is now correctly
populated when generating a Sales Order from an Estimate and having the
"Override SO Due Days for Buy Items with Vendor Lead Time" application
preference enabled.
When picking a new or different item after generating a SO using the
advance SO generation. The Estimating form will no longer display array
index error message.

I1306159

InventoryAdjustment.dll

6.4.55

06/28/2013

I1306092

Altered adjustment to prevent problems if the Lotnumber in inventory
exceeds 25 characters

06/28/2013

I1306105

Additional GL account validation has been added for clients using Seradex
Financials.
The 'Edit Freight' form will now automatically append a blank row when the
form loads.
Reporting options are now disabled while a report is being generated.

Invoice.dll

6.4.80

I1305151
I1305163
I1303142

Invoice document lines can no longer be deleted by users who are not
authorized to delete invoice documents.

I1306066

The Userdefine in the item editor will now be hidden if the userdefined
activation is false.
Now, after labour operations are repositioned in the labour schedule, the item
editor BOM will be updated to reflect the changes.
If users choose to cancel saving an item, they will no longer receive a
message stating the save was aborted.
The following null error message has been corrected when selecting Tools ->
Labour in the Item Editor.

ItemEditor.dll

6.4.72

06/28/2013

I1305178
I1306093
I1306181
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JobCosting.dll

6.4.30

06/28/2013

I1306191
I1306127

Data Validation can now be used within the Job Costing and Opportunities
modules.
When setting the first one or more tabs to invisible using Advanced Security,
the first visible tab will be the tab that is displayed on form load.

MatReq.dll

6.4.66

06/28/2013

I1306097

The MRP form font colour has been changed to white whenever the
background colour is red.

06/28/2013

I1306199

Altered so that approving zero dollar Vendor Invoices when using a custom
accounting system to not set the batch file name.
Data Validation capabilities have been added to the Vendor Invoicing form.

POInvoice.dll

6.4.53

I1306160

RptFinancials.dll

6.4.28

06/28/2013

I1306088

The Open AP and Payment Register reports Date fields have been changed
to use the local date setting on the workstation as its date format.

I1303142

Sales order document lines can no longer be deleted by users who are not
authorized to delete sales order documents.
Reporting options are now disabled while a report is being generated.

SalesOrder.dll

6.4.119

06/28/2013

I1305163
I1305190

If the 'Configurator Batch Mode' and the 'Process Config Search & Replace
and Reconfigure via Batch Mode' Application Preferences are checked, the
line colouring will now correctly reflect the processing state of the line item.

Seradex.DataCRMCampaigns.dll

6.4.7

06/28/2013

I1306038

I1306036

If there any changes made to the prospect's address on the CRM
Campaigns scrubbing form, now the form will no longer update the
addresses table using the AddressID.
Saving on the CRM scrubbing form will no longer cause the Scrubbed flag to
lose its value.

Seradex.Financials.FinancialsSystem.dll

6.4.44

06/28/2013

I1306091

Refund credit payments can no longer be voided

Seradex.Production.Scheduling.dll
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6.4.22

06/28/2013

I1306026

DBR will now update/remove old data as needed from scheduling when the
BOM of a WorkOrder or an Estimate is updated.

I1304235

When search is launched for a module, the search title will now display the
module name. For example selecting Estimate Search from the profile bar
will display search with the title "Estimate Search"
Validation has been added to the search filter. Invalid entries will be
highlighted in red.
Closing a property lookup without selecting a property value will no longer
produce the type mismatch error.
Search will now stop processing linked search requests as soon as the
window is closed.

Seradex.Search.dll

6.4.34

06/28/2013

I1305172
I1306178
I1306183

Seradex.Utilities.UserDefinedPropMaintSystem.dll

6.4.12

06/28/2013

I1306208

The Allow Special checkbox will now pass in a true or false flag.

I1306051

The Userdefined setup form has been adjusted to load only the selected
module userdefined setup records from now on.

Seradex.Win.CRMCampaigns.dll

6.4.9

06/28/2013

I1306036
I1306038

Saving on the CRM scrubbing form will no longer cause the Scrubbed flag to
lose its value.
If there any changes made to the prospect's address on the CRM
Campaigns scrubbing form, now the form will no longer update the
addresses table using the AddressID.

Seradex.Win.Financials.dll

6.4.44

06/28/2013

I1306137
I1306136
I1306091

Prevent anyone from entering a negative discount amount in pay vendor
invoices and payment schedule
Corrected issue if one attempts to pick a payee type after picking the bank
account in the cheque and payment form
Refund credit payments can no longer be voided

Seradex.Win.Search.dll

6.4.24

06/28/2013

I1304235

I1306103
I1306178
I1306183

When search is launched for a module, the search title will now display the
module name. For example selecting Estimate Search from the profile bar
will display search with the title "Estimate Search"
Search lookups launched from financials will now load data when launched.
Closing a property lookup without selecting a property value will no longer
produce the type mismatch error.
Search Setup will now open correctly when launched after viewing searches
in Seradex Financials.

5

Seradex OrderStream
Technical Release Notes
June 2013

Seradex.Win.UserDefinedPropertyMaintenance.dll

6.4.15

06/28/2013

I1306208

The Allow Special checkbox will now pass in a true or false flag.

I1306051

The Userdefined setup form has been adjusted to load only the selected
module userdefined setup records from now on.

I1306107

The Transaction tab on the Service Order form now has the ability to launch
the document upon double clicking the transaction document number.
The Search form in Service Order now has the ability to be resize.

ServiceOrder.dll

6.4.33

06/28/2013

I1306080
I1306076

I1306053
I1305193

The RMA checkbox will now be automatically checked upon the generation
of the RMA No and the ServiceOrder.ReqRMA field on the database will be
updated correctly base on the RMA checkbox.
The keydown array error on the part spread has been corrected and will no
longer display a 'control array doesn't exist' error message.
An adjustment has been made to the validation function on the Service Order
module Transaction tab to ensure that it returns a failure only if the
Transaction Type is invalid.

sxControls.ocx

6.4.22

06/28/2013

I1306186

The Reset Position of Profile Bar function can now be accessed by going into
the File Menu of the dashboard.

I1306150

The 'Allow specials for Rack and Bin' Application Preference can now be
accessed only if the 'Predefined Racks and Bins' Application Preference is
enabled.

I1306186

The Reset Position of Profile Bar function can now be accessed by going into
the File Menu of the dashboard.

I1306206

The userdefineds form will no longer prompt an error message when saving
multi selected properties values that contain the '&' character.

I1306199

Altered so that approving zero dollar Vendor Invoices when using a custom
accounting system to not set the batch file name.

sxMaintenance.dll

6.4.69

06/28/2013

sxRuntime.exe

6.4.23

06/28/2013

sxUserDefineds.ocx

6.4.21

06/28/2013

UpdateAcct.dll

6.4.58

06/28/2013
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6.4.58

06/28/2013

I1306125

Altered MYOB Link to properly update invoice balances

I1305226

Update BV 7 Posting so the Fiscal year and period is derived from the
document date as opposed to the date the user sets the batch date to.

I1303142

Work order document lines can no longer be deleted by users who are not
authorized to delete work order documents.
If using the standard labour preference and you do not have proper GL setup
on either Location (if using the preference) or Cell or Job cost category the
system did give a warning yet still completed the work order line. Now it will
no longer complete the line as that is not proper.
Corrected an issue where if inventory was not transferred to a work order line
and the application preference to record labour in finished goods inventory is
enabled, the data required for day end to properly create the production
batch was not recorded.

WorkOrder.dll

6.4.94

06/28/2013

I1306063

I1306064
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